
Minden nyomda máshogy dolgozik és máshogy kéri az anyagok leadását.
Mivel mi szélesformátumú, digitális nyomtatással foglalkozunk

elsősorban és minden máshoz alvállalkozókkal dolgozunk, ezért mi 
az alábbi módon kérjük a nyomdai grafikai anyagokat leadni.

GRAFIKAI ANYAG LEADÁSA,
AHOGY A FLASH SZERETI,

egy kis oktatással és 
esettanulmányokkal fűszerezve.



A JPG és társai formátum a mindenki által legközismertebb képformátum, de a nyomtató
programja sajnos nem szereti. Lehet vele dolgozni, sőt kell is, mert minden képi alapanyagot
ebben a formátumban fogsz fellelni az interneten, de a végső gyártási fájlod nem lehet jpg
kiterjesztésű, mert összeomlik tőle a VersaWorks, ami a Roland gyári nyomtatási programja.
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2. TIFF – csak nyomtatáshoz
A helyes nyomtatási formátumunk a TIFF lesz. 1:1 méretben, CMYK színbeállítással,
LZW tömörítéssel, réteg nélküli összeolvasztott képfájlként. 
Hogy ezek miért fontosak minden egyes nyomtatási fájl előkészítésekor?

- TIFF, mert ezt szereti a Versa. Szereti még a PDF-et is, de ott is képfájlt kell mentsünk a PDF-en belülre. 
És ha pdf, akkor mindenképp ellenőrizni kell, hogy valóban képfájlt kaptunk-e, ha pedig TIFF akkor arról tudjuk, hogy biztosan jó. 

- 1:1 méret, mert ha a Versaban fogjuk felnagyítani, akkor nagyon pixeles végeredményt kapunk. Hiszen a felbontása nem nő a fájlnak azért,
mert nyomtatáskor felnagyítjuk. 

- CMYK - ebből a 4 színből nyomtat a nyomtató, így lesz színhelyes a beállítás. Azonban RGB-t is képes nyomtatni, de ekkor ne várjunk
színhelyességet. Bár tény, hogy néha sokkal élénkebb nyomatot kapunk, ha RGB-ben hagyjuk a fájlunkat. 

- LZW tömörítés azért jó, mert sokkal-sokkal kisebb méretű fájlt kapunk mentéskor, de nem romlik a képminőség, mint a JPG-nél. 
A JPG kockásítja a fotót, az LZW nem nyúl bele így a képbe. 

- Réteg nélkül pedig azért kell mentenünk (flatten image vagy összeolvasztás), mert szintén jóval kisebb fájlméretünk lesz így. Miért fontos,
hogy minél kisebb legyen a fájlméretünk? Ez két okból lényeges. Egyrészt minek gyűjtsük a terrákat feleslegesen, másrészt a Versa se tud
lekezelni gigabites fájlokat, egyszerűen összeomlik a rendszere.



Minden esetben, ha fóliavágásra készítünk elő grafikát, ügyeljünk arra, hogy az
egész grafika egyetlen réteg legyen, ne fedjék egymást vonalak. 
Ahol a vonal elhalad, ott fog a kés is vágni. 

Így egyesével át kell nézni minden átfedést és egymásba kell olvasztani a
betűket/grafikai elemeket. Így néz ki például a fenti betűtípus vágóvonala,
aminél láthatóan egymásba folynak a betűk:

Alakvágáshoz javasolt grafikai beállítások: Vágott anyagokhoz egyértelműen
vektoros állomány szükséges. Vektorgrafika leadásánál figyeljünk arra, hogy ha
szövegről van szó, nincs mindenkinek meg minden betűtípus. Így vagy mellékeljük a
telepíthető betűtípushoz tartozó fájlt vagy vektorizáljuk, kerekítsük, görbítsük le a
betűket, ki hogy ismeri. Lényeg, hogy vonalak kell legyenek a betűk is. Ebben az
esetben nem kell a betűtípusokkal külön babrálni, azonban utólag már nem tudunk
módosítani a szövegen.
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Az eps lehet pdf is, de szintén jön a fenti magyarázatom a pdf-re, hogy 99%-ban pdf-ben kapjuk a nyomdai fájlt,
így előfordulhat, hogy az általunk gyárthatónak hitt pdf mégsem az, ezért én nem szoktam kockáztatni. 

Ha látom, hogy eps a fájl, tudom, hogy kell plotterezni. Ez csak arról szól, hogy az
évek során ki mit szokott meg.



Ha a betűket sikerült egybe olvasztanunk, akkor a fenti képen látható vektoros grafikát kell kapjunk. 
A fenti képen látható, hogy feleslegesen sok pontból áll a görbénk, amit Corelben és Illusztrátorban 
is két kattintás minimalizálni. Ez azért fontos, mert a kés minden egyes ponton áthalad, számításba veszi 
és sokkal tovább gondolkodik a gép feleslegesen. Fontos még az is, hogy a teljes vágás egyetlen vonal legyen,
olvasszunk egybe mindent, mert a Rolandok olyan “okosak”, hogy abban a sorrendben vágják ki a fájlokat, ahogy
te azt behúztad a programba. Tehát, ha több grafikád van, mint egy, akkor a program lassíthatja ezzel a vágást és
még az anyagot is feleslegesen rángatja előre-háta. Ekkor még a vágás is el tud csúszni, ami miatt kuka lehet az
egész anyag. Ez amúgy meg is fordítható és szándékosan használható, hogy mi irányítsuk a vágási sorrendet.
Ha nincs megfelelően előkészítve a grafika, akkor minden olyan vonal, ami a grafikai állományban szerepel, azt a
plotter ki fogja vágni. Még ha rejtett dolgok vannak a háttérben, azokat is. A vonal a lehető legvékonyabb kell
legyen, ami hairline néven fut Corelben és legyen lekerekítve a vonal sarka. Illusztrátorban pedig törekedj a
legvékonyabb vonalbeállításra, ami 0,01 mm és állítsd be, hogy középen legyen a stroke és itt is sarokkerekítéssel
vágjon. 
A legtöbb nyomdában az Adobe Illusztrátor vagy CorelDraw programokat használjuk. Mivel felfoghatatlan
ütemben jönnek ki az újabb és újabb verziók, így azok kompatibilitása is megkérdőjelezhető. Éppen ezért javasoljuk
az EPS formátumba való kiexportálást, ami bármelyik programmal kompatibilis tud lenni. A vonalakat és mindent is
flattenelni kell a grafikai anyagban, ha Illusztrátorból dolgozol, mert a programban nem is látod, de leduplikálja a
vonalakat, sőt volt, hogy olyan grafikát kaptam amiben 16x volt benne ugyanaz a vágóvonal. És ha ezt mi sem
vesszük észre, amikor ellenőrizzük a kapott anyagot, akkor ott bizony annyiszor fog átmenni a kés, ahányszor a
grafikában benne van és szétvágja a hordozót is és a teflon szalagot is a gépben, aminek senki nem fog örülni.A
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Egy dologra kell biztosan figyelni, ha Illusztrátorból exportáljuk a grafikát. 
A segédvonalakat minden esetben ki kell az exportálás előtt kapcsolni. 
Ha azok benne maradnak, a nyomatban is ilyen nyomot hagynak:

Fehér hajszál vékony csíkok a grafikai tervezés során benne maradtak a
nyomatban, így a nyomtatáskor is látszik. Na ilyen nincs a Corelben.

A CHATGPT ezeket javasolja:
Ha egy Adobe Illustratorban készült vektoros vonalrajzot behúzol
CorelDRAW-ba, és az szétesik vagy nem jelenik meg megfelelően, annak
több oka is lehet. Íme néhány gyakori probléma és megoldás:

1. Nem kompatibilis fájlformátum

2. Importálás helyett másolás-beillesztés

3. Vágómaszkok és rétegek kezelése

AI fájl megnyitása: A CorelDRAW nem mindig kezeli jól a natív .AI formátumot, különösen az újabb verziókat.
Megoldás: Mentsd el az Illustrator fájlt PDF, EPS vagy SVG formátumban, és úgy próbáld meg megnyitni.

Ha Illustratorból egyszerűen kimásolod és beilleszted a vektorokat Corelbe, előfordulhat, hogy a vonalak
szétesnek vagy eltűnnek.
Megoldás: Ahelyett, hogy másolás-beillesztést használsz, próbáld meg fájlként importálni (File → Import).

 Az Illustratorban létrehozott vágómaszkok vagy összetett rétegek problémát okozhatnak Corelben.
 Megoldás: Illustratorban egyszerűsítsd a rétegeket, bontsd fel a vágómaszkokat (Object → Clipping Mask →
Release), majd mentsd el újra.A
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4. Színek és áttetszőségek átalakulása

Van azért kivétel, amikor jó a PDF, ez a lakk vagy fehér nyomtatása és a sorszámozás a Versában.
A lakk és fehér nyomásra nem minden gép alkalmas, nálunk mindkét UV nyomtató tudja ezeket. 
A Dimenz nyomtatónk is a pdf-et szeretni.

5. Betűk és szövegek átalakulása

6. Vonaltípusok és stroke kezelés

7. Túl új fájlverzió
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eltűnhetnek.
 Megoldás: Illustratorban alakítsd át az áttetszőségeket raszteres elemekké, vagy vektorosítsd őket
egyszerűbb formákra.

 Ha az Illustrator fájlban szövegeket használsz, azok Corelbe importáláskor eltűnhetnek vagy torzulhatnak.
 Megoldás: Alakítsd át a szöveget görbévé (Type → Create Outlines) Illustratorban, mielőtt mented a fájlt.

 Az Illustratorban beállított különleges vonaltípusok (pl. szaggatott vonalak, vastagságok) nem mindig
konvertálódnak megfelelően.
 Megoldás: Illustratorban alakítsd át a vonalakat alakzattá (Object → Path → Outline Stroke), így biztosan
vektoros objektumként kerülnek át Corelbe.

 A CorelDRAW nem mindig támogatja az Illustrator legújabb verzióját.
 Megoldás: Illustratorban mentsd el egy korábbi verzióban (pl. Illustrator CS6 vagy régebbi).

4. PDF



Az általunk gyártott nyomatok esetében az alábbi felbontások a grafikák minimum és maximum elvárt értékei:

Egy dolog változtathat ezen, ha a nagy méreteknél valamiért nagyon apró betűk is
nyomtatandók, akkor max. 250 dpi-vel kell dolgozni, de csak ha igénylik az olvashatóságát.

Mert én azt mondtam… amúgy nem, természetesen. Azért kérem, hogy minden nyomtatásra kerülő anyag Photoshopon keresztül
kerüljön leraszterizálásra, mert:

A különböző programok közti kompatibilitási hibák itt nem jönnek ki, mert a Photoshop jól kezeli és jelzi, ha bármilyen font pl.
hiányozna, hogy szerkeszthető legyen a file, de mi ugye abba nem nyúlunk bele nyomdai előkészítéskor. Nekünk az a fontos, hogy
egyetlen képfájlunk legyen a nyomtatandó anyagban. Így a VersaWorksnek esélye sincs indokolatlan módon szétszedni a grafikát
vagy eltüntetni belőle egyes elemeket.

A Photoshopba amikor behúzod a fájlt, egyből be tudod állítani a felbontást, látod, hogy mekkora méretben kaptad meg a
grafikát, ellenőrizni tudod a kapott információkat egyszerűen, mielőtt hozzá fognál bármihez.

Egy dologra figyelj, ha túl nagy felbontásban húzod be a grafikát, akkor eltorzítja a Photoshop, nehogy véletelenül rossz méretben
maradj! Ha már a Photsohop is jelzi, hogy túl nagy a fájl, akkor biztos, hogy elég a kisebb felbontás neki.

Nagy méret (kirakat, jármű, padlómatrica, nagy táblák): min. 120 / max. 200 dpi
Zászlók: min. 100 dpi / max. 200 dpi
Festővászon: min. 120 / max. 200 dpi
Molinók, ponyva, mesh háló, citylight plakát: min. 72 dpi / max 150 dpi
Műanyag és karton alapú táblák: min. 120 / max. 200 dpi
Roll-up: min. 120 / max. 200 dpi

B/ Felbontás és méretezés

C/ Miért kell raszterizálni minden nyomtatott anyagot Photoshopban?



a. CutContour: vágókontúr, vagyis a program, ha ezt a spotcolort látja, tudja, hogy itt kell a plotterkést használnia, itt
fogja vágni az anyagot. Ugyanezt használjuk táblavágáshoz is, bár ott nem fontos a JWEI programnak csak vektoros
grafika kell, így viszont nem kell külön vágófájlt készítenünk a táblavágáshoz, hanem ugyanaz a grafikai anyag
használható, amit nyomtatáskor is használunk, nincs kavarodás.

b. RDG_WHITE: Ha ezt a színt állítod be a nyomdai anyagban, ide fog fehéret nyomtatni a gép. 
Nekünk az UV nyomtatónk tud fehér színt nyomtatni.

c. RDG_GLOSS: Itt lakkot fog nyomtatni a gép, ami lehet matt vagy fényes és igen, bármilyen formája lehet, te
rajzolod meg vektorosan. Szintén az UV nyomtatónk használja.

d. RDG_STRUCTURAL: Ezt a spot colort a Dimenz nyomtatónk használja csak. Ahova beállítod ezt a színt, ott nem fog
feldomborodni az alapanyag. A Dimenz nyomtatásról több infót találsz a dombortapeta.hu vagy a flashdimenz.hu
oldalainkon.

e. RDG_MetallicSilver: A VersaWorks program itt egy adott metál színt használna, ezüstöt vagy aranyat, ha lenne a
nyomtatónkban, de annyira ritka az ilyen megkeresés, hogy a mi nyomtatóink ezt nem tudják. Viszont ahhoz, hogy
biegelni tudjunk a JWEI programjának kellett egy másik direkt szín, amit a Versa nem nyomtat ki, így mi ezt biegelésre
használjuk a karton alapanyagok hajtogatásánál.

A Roland VersaWorks programjához beállított spot colorok speciális, előre határozott színek, amelyeket a szoftver
automatikusan felismer és tudja, hogy azt nem szabad nyomtatnia, mert azzal valami más feladat lett neki megadva.
Mi ezeket használjuk:

D / Spot colorok



Bleed limit - Corelnél érvényes eps exportálásakor, mert ilyenkor hagy egy pici kifutót az egész grafikának. 0,03 mm-
t elég beállítani, mert így a hairline vastagságú CutContour-unkat nem fogja levágni az exportáláskor a program. 
Sokszor tapasztaltam már, hogy az eps-nél egy vagy két oldalon a grafika szélén eltűnik a vágóvonal, és a plotter
nem vág semmit, pedig hát én megrajzoltam. Na ez ezért van. 

Kifutó - Hasonló a dolog, csak itt nem elég egy fehér szín, ami nem látszik nyomtatásban, ide kell a grafika is.
Érdemes minden grafikához túlfutó grafikát (ki milyen néven ismeri) tenni. Ekkora méreteknél, amikkel dolgozunk, bele
kell kalkulálni az emberi tényezőt, azt, hogy emberek helyezik ki az ablakra/kasírozzák táblára a vinylt/hajtják vissza
a molinó szélét stb. Azaz néhány milliméteres tévedésekkel kell kalkulálni. Ide csak olyan grafikai elemet tegyünk, ami
nem baj, ha eltűnik kihelyezéskor, például égbolt, fű vagy bármi olyan grafika, amit tartalmaz a képünk.

Nagyon okos dolognak tartom a mesterséges intelligenciát, mert iszonyatosan gyorsítja az életünket, amikor kifutót
kell csinálnunk. Photoshop/Edit/Fill/Content aware például. Sok egyéb módja is van, ezekre érdemes rákeresni a
youtubeon és tutorialokból tanulni. Természetesen ellenőrizni kell a végeredményt, mert néha azért előfordul, hogy
utána kell javítanunk kicsit. De korántsem kell órákat szöttyögnünk és copyzással bajlódnunk, helyette pár másodperc
alatt kész a kifutónk.
Fontos dolog még a nyomtatás és vágás esetén is a kifutó, mert akármennyire hihetetlen, de a gépek is képesek
hibázni, bár valószínűleg emögött is inkább az emberi tényező áll, például egy rosszul visszafogott alapanyag. Amikor
kinyomtatunk egy grafikát, ha nem kell laminálni, akkor a plotter akár nyomtatás előtt, vagy utána is képes kivágni azt.
Itt kisebb az emberi tényező, mint akkor, amikor le kell laminálni a nyomatot és utána vissza kell fogni a gépbe.
Minden egyes vágásnál, ha nincs jól bekalibrálva a gép, a vágásunk elcsúszhat. Ezért általában legalább 5 mm, de
inkább 1 cm-es kifutókkal érdemes elkészíteni ezeket a grafikákat. A grafika tervezésekor pedig figyelembe kell
venni, hogy a grafika szélére ne tervezzünk olyat, amit bánni fogunk, ha eltűnik.

E/ Bleed limit lényege és kifutó



1. Helyszíni kihelyezésnél minden alkalommal 1 cm kifutót használunk, minden irányba. 

2. Ha egy nagyobb, összefüggő falat kell például bedekorálnunk, akkor viszont más a gyerek fekvése. Bal felülről fog
elkezdeni dolgozni a dekoros, így az lesz a nullpontunk. Így balra és felfelé nem kell neki kifutó, mert a felülethez
igazítja a vinylt. Ezesetben, mivel nagyobb felületről van szó, megeshet, hogy az illesztések nem úgy sikerülnek, ahogy
az a nagykönyvben meg van írva, ezért elcsúszhatunk a mérettel. Itt ezért szoktam hagyni jobbra és lefelé 3-3
centiméter kifutót. Megesik az is, hogy nem vízszintes a felület, hiszen emberek építették, ezért érdemes minden
irányát megmérni a falnak.

3. A gépi formavágásnál fent leírtam, hogy ugye tévedhet a gép, ezért a plotteres és síkágyas vágásnál is érdemes 
5 mm kifutót hagyni.

4. Ha bármilyen olyan dekorálandó felületet, például táblát kapunk, ami már méretre van vágva, ugyanúgy kell
vennünk, mintha kültéri kihelyezés lenne, körbe 1 cm kifutó mindenhol kell.

5. Autóknál egyedi méretekkel dolgozunk, de 5 centis kifutót szoktam kérni a grafikákra általában.

Mikor és miért kell kifutó?



Na ez egy nehéz kérdés. A legtöbb nyomda a Coated Fogra 27 vagy 39 színprofilt kéri, ami egyébként jó, mert ettől
lesz európailag színhelyes a nyomatunk. Mi sose nyúlunk az eredetileg beállított színprofilhoz, kivéve: sokszor ütközünk
abba, hogy a színprofil miatt incorrekt választ kaptunk a nyomtatótól vagy egyszerűen csak úgy csinál, mintha
nyomtatna, de nem nyomtat semmit. Ilyenkor kikapcsoljuk az eredetileg beállított színprofilt a Photoshop/Assign Profil
résznél és nem lesz ettől nem színhelyes a nyomatunk. A lényeg, hogy cmyk maradjon a fájl.

A színátmeneteknél sokszor láthatunk olyat, hogy széttördeli az összes program az átmenetet
csíkonként más színre, mert nem bírja lekezelni a színátmenetet. Ez Illusztrátorban egy
kattintás: gradient mesh funkció legyen kipipálva. Nem biztos, hogy tökéletes lesz a
végeredmény, de segít rajta. Ha nem vektoros az anyagunk, akkor csak az maradt, hogy
zajjal tompítjuk a csíkok élét (max 3%) . Ez csak közelről lesz látható, ezt egyébként, ha pixeles
a grafika, akkor is lehet alkalmazni, mert a szemet át lehet vele verni, de bizonyos távolságból
áll neki jól csak.

F/színprofil

G/ színátmenet


	D / Spot colorok
	E/ Bleed limit lényege és kifutó
	Mikor és miért kell kifutó?
	F/színprofil
	G/ színátmenet

